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Getting Started with Office 2013 
Whether you’re new to Office or just new to Office 2013, get started by exploring its 
interface and navigation tools in Chapter 1. Next, connect Office with your Microsoft 
account and any social sites you want to share with (see Setting Up Your Account on 
page 14). Also familiarize yourself with tasks common to multiple Office applications  
(see Checking Spelling on page 40; Inserting a Picture from Your Computer on  
page 44; and Inserting a Shape on page 56). Finally, learn to go mobile with SkyDrive  
and Web Apps (see Getting Started with SkyDrive on page 66). 

Creating Documents with Word
Word makes it easy to create all types of documents. To simplify document creation,  
try one of Word’s many templates (see Creating a Document from a Template on  
page 82) and then format your document for a consistent look (see Adding Headers  
and Footers on page 104). If you work with others, you’ll appreciate Word’s collaboration  
tools (see Tracking Changes with Document Reviewers on page 134). 

Calculating and Analyzing with Excel
With Excel, you can perform calculations, create charts, and analyze data. Excel formulas 
simplify calculations (see Creating a Simple Formula on page 178). After entering data, 
display it graphically using charts and PivotTables (see Inserting a Chart on page 190  
and Creating a PivotTable on page 194). 

Designing Presentations with PowerPoint
Using PowerPoint, you can create an eye-catching presentation—even if you’re  
design-challenged. Get started with a color-coordinated theme and predesigned slide  
layouts (see Creating a New PowerPoint Presentation on page 200). Then enliven  
your presentation with animation, audio, and video (see Chapter 17). Finally, deliver  
your slide show in person or on the Web (see Presenting Your Show on page 252  
and Presenting Online on page 254). 

Staying in Touch with Outlook
Outlook is the perfect tool for communicating with others via email (see Sending an 
Email Message on page 264 and Receiving and Reading Your Email on page 265).  
You can also manage your schedule (see Scheduling an Appointment on page 281)  
and track and read your favorite blogs (see Subscribing to RSS Feeds on page 290). 

Tracking Information with OneNote
OneNote is a handy organizational tool that helps you track information. To get  
started, see Creating a New Notebook on page 296. In addition to adding text,  
pictures, and links, you can also incorporate multimedia (see Recording Audio on  
page 312 and Recording Video on page 313).

THE�LEAST�YOU�NEED�TO�KNOW
Easy Microsoft Office 2013’s concise, easy-to-understand tasks get you up and running quickly on 
Microsoft Office’s five most popular applications: Word, Excel, PowerPoint, Outlook, and OneNote.
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IT’S AS EASY AS 1-2-3  
 Each part of this book is made up of a series of short, 
instructional lessons, designed to help you under-
stand basic information.  

   1.    Each step is fully illustrated to show you how it 
looks onscreen   

  2.    Each task includes a series of quick, easy steps 
designed to guide you through the procedure.   

  3.    Items that you select or click in menus, dialog 
boxes, tabs, and windows are shown in  bold .    

 Tips, notes, and cautions give you a heads-up for 
any extra information you may need while working 
through the task.  

  How to Drag:  Point to the starting place or object. 
Hold down the mouse button (right or left per instruc-
tions), move the mouse to the new location, and then 
release the button.  

  Click:  Click the left mouse button once.  

  Click & Type:  Click once where indicated and begin 
typing to enter your text or data.  

  Selection:  Highlights the area onscreen discussed in 
the step or task.  

  Double-click:  Click the left mouse button twice in 
rapid succession.  

  Right-click:  Click the right mouse button once.  

  Pointer arrow:  Highlights an item on the screen you 
need to point to or focus on in the step or task.     

xvi

53

Start

End

53  CROPPING A PICTURE  
 If you don’t want to include an entire picture, you can crop it to your exact specifi cations. 
For example, you might want to zero in on an object in the center of a picture, or remove 
extra content at the top of a picture.  

    1.   Select the picture you want to crop.   

   2.   On the Picture Tools–Format tab, click the  Crop  button.   

   3.   Handles surround the picture, enabling you to specify the exact content you want 
to retain.    

     4.   Drag the mouse to determine your cropping area.      

          

          

   TIP 

 Crop to Fit a Shape      You can also crop a picture to 
fi t in a specifi c shape by clicking the down arrow 
below the Crop button and selecting  Crop to 
Shape  on the menu.         

Rutledge_Book 1.indb   xvi 2/7/13   4:49 PM
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INTRODUCTION TO  
EASY OFFICE 2013   
 Microsoft Offi ce 2013 is the latest version of Micro-
soft’s popular suite of business software applications. 
Using Offi ce, you can quickly create documents such 
as letters, reports, and resumes; calculate and analyze 
data in spreadsheets; design and deliver presenta-
tions; send and receive email; and store data in 
digital notebooks.  

 The world is becoming increasing mobile, and so is 
Offi ce 2013. This new version is integrated with Sky-
Drive, Microsoft’s online storage solution. In addition 
to web-based fi le-sharing, SkyDrive also gives you 
access to the Microsoft Web Apps for Word, Excel, 
PowerPoint, and OneNote. Offi ce 2013 makes it easy 
to access, edit, and create Offi ce fi les on the go, us-
ing a mobile device such as a tablet or smartphone.  

  Easy Microsoft Offi ce 2013  is designed to get you 
up and running on Offi ce as quickly as possible. This 
book covers fi ve of the most popular Offi ce applica-
tions—Word, Excel, PowerPoint, Outlook, and One-
Note—and provides visual, step-by-step instructions 
that help you master tasks with little effort. For now, 
turn to  Chapter   1   , “Getting Started with Microsoft 
Offi ce 2013,” to begin exploring this powerful 
application suite.  

  WHO THIS BOOK IS FOR  

 This book is for you if...  

    •    You want to become productive with the latest 
version of Offi ce as quickly as possible and are 
short on time.   

   •    You’re new to Offi ce and need to learn the 
basics in an easy-to-understand format.   

   •    You’re a visual learner and want to  see  what to 
do rather than read lengthy paragraphs describ-
ing what to do.     

  HOW THIS BOOK IS ORGANIZED  

  Easy Microsoft Offi ce 2013  is divided into six parts.  

  Part   I   , “Microsoft Offi ce 2013,” introduces Offi ce fun-
damentals, such as navigating applications, using the 
Ribbon and Backstage view, getting help, and saving 
and opening fi les. If you’re an experienced computer 
user but are new to Offi ce, these chapters provide a 
foundation for using the Offi ce suite. If you’ve used 
Offi ce in the past, they can serve as a quick review 
and introduce you to the new, exciting features of 
Offi ce 2013.  

 In  Part   II   , “Microsoft Word 2013,” you continue on to 
one of the most popular Offi ce applications: Microsoft 
Word. In this section, you learn how to create and 
format documents, modify page layout, and perform 
a collaborative review of your documents before you 
print, publish, or send.  

 Next, you can start exploring Excel, Offi ce’s spread-
sheet application.  Part   III   , “Microsoft Excel 2013,” 
shows you how to create and format Excel workbooks 
and worksheets and introduces you to cell formulas 
and functions. Finally, you can analyze your worksheet 
data using visual tools such as charts, PivotTables, and 
sparklines (mini charts).  

  Part   IV   , “Microsoft PowerPoint 2013,” shows you how 
to create eye-catching presentations using Power-
Point’s powerful collection of ready-made tools, even 
if you’re design-challenged. You also learn how to edit 
and format presentations; incorporate audio, video, 
and animation; and prepare for delivery, either in per-
son or on the Web.  

  Part   V   , “Microsoft Outlook 2013,” helps you get up 
and running quickly with Offi ce’s email, calendaring, 
and scheduling tools.  

 And fi nally, you explore OneNote, Offi ce’s digital 
notebook application that helps you organize masses 
of data.  Part   VI   , “Microsoft OneNote 2013,” introduc-
es you to OneNote basics, such as creating, enhanc-
ing, managing, and sharing notebooks.          
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 WORKING WITH TEXT  
    Adding text in an Offi ce application is easy; just start typing. If the default 
text formatting doesn’t suit your needs, however, Offi ce also offers numer-
ous text formatting and customization options.  

 The Home tab in Word, PowerPoint, and Excel is “home” to a solid collec-
tion of text-formatting tools, giving you the option to select a font style and 
size, change text color, or apply bold, italic, and underlining to your text.  

 You can also align text, use WordArt to create sophisticated text objects, 
search for and replace text, and use the Font dialog box for more advanced 
formatting.  

 Finally, you can fi x any spelling errors by performing a spell check—which 
you need to do on every Offi ce document.       

   Chapter 3 
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  USING THE FONT DIALOG BOX TO FORMAT TEXT  
 The Font dialog box offers some advanced formatting options not available on the 
Home tab.    

            

    1.   Select the text you want to format.   

   2.   Click the dialog box launcher in the Font group.   

   3.   In the Font dialog box, select a formatting option.   

   4.   Click the  OK  button to close the dialog box and apply the font formatting.    

  NOTE 

 Font Tab in Excel      In Excel, clicking the dialog 
box launcher opens the Format Cells dialog box 
with the Font tab selected. This tab offers many 
of the same options as the Font dialog box.      

Rutledge_Book 1.indb   34 2/7/13   4:50 PM



35

Start

End

  ALIGNING TEXT  
 You can quickly align text using buttons on the Home tab.    

  

    1.   Select the text you want to align.   

   2.   Click the  Align Left  button to align your text to the left (the default).   

   3.   Click the  Center  button to center your text, such as a heading.   

   4.   Click the  Align Right  button to align your text to the right.   

   5.   Click the  Justify  button to justify your text.    

  NOTE 

 Justifi ed Text      When you justify text, it’s 
stretched or compressed to align to both 
the left and the right.      
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  FINDING AND REPLACING TEXT  
 At times, you might need to change a word or phrase that’s used throughout a 
document. The Find and Replace dialog box makes it easy to replace text, especially in 
long documents.    

  

    1.   On the Home tab, click the  Replace  button.   

   2.   In the Find and Replace dialog box, enter the text you’re searching for in the 
Find What box.   

   3.   Enter the replacement text in the Replace With box.   

   4.   Click the  Replace  button to make the replacement.  

  NOTE 

 Finding Text      If you don’t want to approve 
each instance of a replacement, you can 
click the  Replace All  button to handle this 
process all at once.     

  NOTE 

 Excel Navigation      In Excel, click the 
 Find & Select  button, and select  
Replace  from the menu to open the 
Find and Replace dialog box.       

Rutledge_Book 1.indb   36 2/7/13   4:50 PM



37

End

             

  NOTE 

 Finding Text      Just want to fi nd specifi c text 
rather than replace it? Enter the text in the Find 
What box, and click the  Find Next  button. You 
can also click the  Find  button on the Home tab 
to perform a search.     

   5.   Offi ce notifi es you when the process is fi nished. Click  OK  to close the notifi cation.   

   6.   Click the  Close  button to close the Find and Replace dialog box.    

  NOTE 

 More Options      Click the  More  button to display 
more fi nd-and-replace options. For example, you 
might want to replace only text with matching 
case or search only for whole words.      
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  INSERTING WORDART  
 WordArt enables you to create special text effects such as shadowed, rotated, stretched, 
and multicolored text.      

            

            

    1.   On the Insert tab, click the  Insert   WordArt  button.   

   2.   In the WordArt gallery, click the WordArt style you prefer.   

   3.   Replace the placeholder text with text you want to format using WordArt.    

  CAUTION 

 Don’t Overuse WordArt      Be careful not 
to overuse WordArt, or it can become 
cluttered and confusing. Use WordArt 
only for emphasis.     

  NOTE 

 WordArt Navigation      This example demonstrates adding 
WordArt in Microsoft Word. In PowerPoint, click the  Word-
Art  button on the Insert tab. In Excel, click the  Text  button 
on the Insert tab, and select  WordArt  from the menu.      
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  FORMATTING WORDART  
 Offi ce offers a wide selection of formatting options for WordArt. You can apply a 
Quick Style, gradients, textures, bevels, rotations, and more.    

  

    1.   Select the WordArt object you want to format.   

   2.   The Drawing Tools–Format tab displays.   

   3.   Format your WordArt object using the options on this tab, in particular those in the 
WordArt Styles group.    

  NOTE 

 Text Fill and Text Outline      The Text Fill button and Text 
Outline button include a down arrow to their right that 
displays an extensive menu of options. Clicking the button 
directly applies the default. Clicking the  Text Effects  button, 
however, displays the menu; there is no default to apply.      

Open Format 
Shape pane

Quick 
Styles

Text 
fi ll

Text outline
Text effects
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  CHECKING SPELLING  
 Creating quality, error-free, and easy-to-read content is a natural objective when you 
use an Offi ce application. Fortunately, Offi ce offers a spelling checker to help eliminate 
spelling errors. You can also spell check your entire document at once.    

        

    1.   On the Review tab, click the  Spelling & Grammar  button. (In Excel and PowerPoint, this 
is called the Spelling button.)   

   2.   The Spelling pane opens, and the spell checker starts examining your document.   

   3.   Select the correct spelling, and click the  Change  button.   

   4.   Click the  Ignore  button if the suspected misspelling isn’t an error.   

   5.   Click the  Add  button to add the word as-is to the dictionary.  

  NOTE 

 No Spelling Errors      If your document contains no 
errors, Offi ce displays a dialog box informing you 
of this and doesn’t open the Spelling pane.     

  TIP 

 Change or Ignore All      To save time, you can click 
either the  Change All  button or  Ignore All  button to 
resolve all instances of the suspected error at once.       

Suspected 
misspelling
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   6.   Offi ce notifi es you when the spelling checker is fi nished. Click  OK  to close the 
notifi cation.    

  CAUTION 

 Spelling Checker Limitations      Keep in 
mind that although an automated tool 
can help you catch errors, it isn’t foolproof 
and doesn’t take the place of thorough 
proofreading by a person.     

  NOTE 

 Spelling Options      By default, Offi ce checks spelling as you type 
and displays a red squiggly line under all suspected misspellings. 
To modify the default spell-checking options, click the  File  tab, 
select  Options  in Backstage view, and click  Proofi ng .          
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  copying and moving from one presentation 
to another,   218 - 219  

  deleting,   220  
  slide masters,   221  
  slide shows,   248 - 249  
  slide size,   212  

  Slide Sorter view,   216 - 217  
  slide transitions,   236 - 237  

  SmartArt,   61  
  switching to new layouts,   204  
  themes,   199 ,  213  
  timings, rehearsing,   250   

   presentations (PowerPoint)  
  adding  

  comments,   244  
  headers/footers,   224  
  sections,   206 - 207  

  applying new slide layout,   212  
  comparing,   246 - 247  
  creating,   199 - 201  

  handouts in Word,   225  
  from PowerPoint presentations,   257  

  design options,   211    
  formatting backgrounds of slides,   214 - 215  
  inserting  

  hyperlinks to other slides in your 
presentation,     223

  hyperlinks to the web,   222  
  online video,   230 - 231  
  video clips from your computer,   232  

  managing comments,   245  
  outlines,   208 - 209  
  organizing slides with slide Sorter view,   216 - 217  
  presenting,   252 - 253  

  online video,   254 - 255  
  printing,   226 - 227  
  recording voice narrations,   251  
  slide masters,   221  
  slides  

  copying and moving from one presentation 
to another,   218 - 219  

  deleting,   220  
  themes, applying,   213  
  timings, rehearsing,   250   

   Presenter View (PowerPoint),   249 ,  256   

   presenting slide shows (PowerPoint),   252 - 253  
  online,   254 - 255   

   Print Preview (PowerPoint),   227   

   printing  
  fi les,   26 - 27  
  presentations (PowerPoint),   226 - 227   

   promoting pages (OneNote),   302   
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   protecting workbooks (Excel) with passwords,   
158 - 159   

   publishing Calendar (Outlook),   285    

  Q 
   Quick Access Toolbar,   8   

   Quick Parts  
  adding (Word),   88 - 89  
  removing (Word),   89   

   Quick Styles (Word),   87   

   Quick Tables (Word),   91    

  R 
   reading messages (Outlook),   265   

   Reading pane (Outlook),      259

   rearranging pages (OneNote),   301   

   receiving messages (Outlook),   265   

   Recent Folders list,   21   

   recording  
  audio (OneNote),   312  
  video (OneNote),   313  
  voice narrations (PowerPoint),   251   

   rehearsing timings (PowerPoint),   250   

   rejecting changes  
  in PowerPoint,   247  
  Word,   139   

   removing  
  blank pages (Word),   101  
  cells (Word),   94  
  comments (Word),   137  
  cover pages (Word),   100  
  drop caps (Word),   110  
  email accounts (Outlook),   261  
  hyperlinks (PowerPoint),   223  
  Quick Parts (Word),   89  
  sections from PowerPoint presentations,   207   

   renaming  
  fi les,   17  
  worksheet tabs (Excel),   155   

   replacing text,   36 - 37   

   replying to messages (Outlook),   266 - 267   

   resizing  
  pictures,   52 ,  303  
  in Word,   96   

   Review tab (Word),      134

   Reviewing Pane (Word),     135   

   Revisions pane, closing (PowerPoint),   246   

   Ribbon,   4 - 5   

   rows  
  adjusting height of (Excel),   169  
  deleting  

  in Excel,   153  
  in Word,   94  

  inserting  
  in Excel,   151  
  in Word,   93   

   RSS feeds  
  subscribing to (Outlook),   290 - 292  
  unsubscribing (Outlook),   292   

   rules for managing spam (Outlook),   272 - 273    

  S 
   saving  

  documents (Word),   79  
  fi les to your computer,   20 - 21  
  as PDFs,   22 - 23  
  to SkyDrive,   21  
  as XPS documents,   22 - 23   

   scheduling  
  appointments (Outlook),   281  
  meetings (Outlook),   282 - 283   

   Screen Clippings,   63   

   screenshots, inserting,   62 - 63   

   ScreenTip button,   114   

   searching contacts (Outlook),   275   

   sections  
  adding to PowerPoint presentations,   206 - 207  
  OneNote  

  coloring,   298  
  creating,   298  
  deleting,   298  
  merging,   299  
  moving,   299  

  removing from PowerPoint presentations,   207   

   selecting text (Word),   81   
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   sending  
  fi les to OneNote,   319  
  messages (Outlook),   264 - 265  
  tasks to Outlook (OneNote),   318   

   sequential data, entering (Excel),   150   

   shapes,   54  
  circles,   57  
  formatting,   58 - 59  
  inserting,   55 - 57  
  options,   55  
  squares,   57  
  straight lines,   57   

   Share window,   25   

   sharing  
  Calendar (Outlook),   283 - 285  
  fi les,   24 - 25   

   shortcuts, saving,   20   

   Show Markup drop-down menu (Word),   138   

   sizing pictures,   52  
  OneNote,   303   

   SkyDrive,   64  
  exploring,   65    
  fi les  

  creating new,   72 - 73  
  editing,   74 - 75  
  uploading to,   70 - 71  

  folders  
  creating,   67  
  managing,   68 - 69  

  getting started,   66  
  saving to,   21   

   slide details, viewing,   217   

   slide masters (PowerPoint),   221   

   slide objects, animating (PowerPoint),   238 - 239   

   Slide Show tab (PowerPoint),   243     

   slide shows (PowerPoint)  
  presenting,   252 - 253  

  online,   254 - 255  
  setting up,   248 - 249   

   slide size,   212   

   Slide Sorter view (PowerPoint),   216 - 217   

   slide transitions, setting (PowerPoint),   236 - 237   

   slides (PowerPoint)  .   See also  slide shows 
  adding,   203 - 204  
  with bullet lists,   205  
  copying and moving from one presentation 

to another,   218 - 219  
  deleting,   217 ,  220  
  details, viewing,   217  
  masters,   221  
  moving,   218 - 219  
  organizing, Slide Sorter view,   216 - 217  
  slide objects, animating,   238 - 239   

   SmartArt,   54 ,  60 - 61   

   SmartArt Tools-Design tab,      61

   sorting, data, worksheets (Excel),   172   

   spam, creating rules for managing (Outlook),   
272 - 273   

   sparklines, adding to charts (Excel),   196 - 197   

   spelling, checking,   40 - 41   

   Spelling & Grammar button,   40   

   Spelling pane,   40   

   splitting table cells (Word),   97   

   squares, creating,   57   

   start screen,   2-  3     

   straight lines,   57   

   styles, applying  
  picture styles,   50  
  in Word,   87   

   subpages, creating (OneNote),   302 - 300   

   subscribing to RSS feeds (Outlook),   290 - 292   

   SUM function,   184 - 185   

   switching  
  layouts (PowerPoint),   204  
  between notebooks (OneNote),   296   

   symbols, inserting (Word),   112 - 113   

   syncing (Outlook),   278    

  T 
   table cells (Word)  

  merging,   96  
  splitting,   97   
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   tables  
  cells (Word)  

  merging,   96  
  splitting,   97  

  creating (Word),   90  
  deleting (Word),   95  
  formatting worksheets (Excel) as,   166 - 167  
  OneNote  

  formatting,   311  
  inserting,   311  

  Quick Tables (Word),   91  
  styles, applying (Word),   92   

   tabs, setting up (Word),   128 - 129   

   tags, applying (OneNote),   304   

   task panes,   11   

   tasks  
  color-coding (Outlook),   288  
  creating (Outlook),   286 - 287  
  managing (Outlook),   288  
  sending, to Outlook (OneNote),   318   

   templates  
  applying (OneNote),   306  
  creating documents (Word),   82 - 83  
  creating workbooks (Excel),   146 - 147   

   testing hyperlinks (PowerPoint),   223   

   text  
  aligning Home tab,   35  
  centering (Excel),   163  
  fi nding,   36 - 37  
  fi nding and replacing,   36 - 37  
  formatting  

  Font dialog box,   34  
  Home tab (Word),   33    

  formatting (OneNote),   300  
  merging worksheets (Excel),   163  
  replacing,   36 - 37  
  selecting (Word),   81  
  wrapping in worksheets (Excel),   162   

   text boxes, inserting (Word),   108 - 109   

   text color, changing (Word),   86   

   Text Fill button,   39   

   text notes,      300

   Text Outline button,   39   

   themes  
  Offi ce theme,   15  
  PowerPoint,   199 ,  213  
  Word,   86 ,  130 - 131   

   thickness, changing (OneNote),   316     

   timestamps, adding (OneNote),   314   

   timings, rehearsing (PowerPoint),   250   

   titles (OneNote), adding page titles,   297   

   To-Do List view (Outlook),   287   

   toolbars  
  mini toolbar,   9  
  Quick Access Toolbar,   8   

   Track Changes feature (Word),   134   

   tracking changes with document reviewers (Word), 
  134 - 135   

   types of indents (Word),   125    

  U 
   Undo button (OneNote),   317   

   unfreezing panes (Excel),   171   

   uploading fi les (SkyDrive),   70 - 71    

  V 
   video  

  creating from PowerPoint presentations,   257  
  deleting (PowerPoint),   231  
  formatting (PowerPoint),   233  
  inserting (PowerPoint),   232  
  online video, inserting (PowerPoint),   230 - 231  
  recording (OneNote),   313   

   View modes (Word),   132   

   viewing  
  Calendar (Outlook),   280  
  contacts (Outlook),   275  
  document markup (Word),   138  
  slide details,   217   

   voice narrations (PowerPoint)  
  deleting,   251  
  playing,   251  
  recording,   251    
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  W 
   weather (Outlook),   280   

   Word,   76    
  adding  

  comments,   136 - 137  
  headers/footers,   104 - 105  
  Quick Parts,   88 - 89  

  applying table styles,   92  
  bullet lists, creating,   84 - 85  
  changes, accepting/rejecting,   139  
  changing text color,   86  
  comparing documents,   139  
  creating  

  documents from templates,   82 - 83  
  handouts,   225  

  deleting  
  rows and columns,   94  
  tables,   95  

  document views,   140 - 141  
  documents, starting new,   80  
  editing headers/footers,   106 - 107  
  exploring document views,   140 - 141  
  Home tab,   33    
  Insert tab,     
  inserting  

  blank pages,   101  
  bookmarks,   115  
  cover pages,   100  
  dates,   111  
  drop caps,   110  
  hyperlinks,   114  
  page breaks,   102  
  page numbers,   103  
  rows and columns,   93  
  symbols,   112 - 113  
  text boxes,   108 - 109  

  merging table cells,   96  
  number lists, creating,   84 - 85  
  opening documents,   80  
  page layout,   116    

  adding indents,   124 - 125  
  applying page borders,   122 - 123  
  changing line spacing,   126  
  changing page margins,   117  
  changing page size,   120  
  controlling paragraph spacing,   127  

  creating columns,   121  
  modifying page orientation,   119  
  setting tabs,   128 - 129  

  program screen, 77
Quick Styles,   87  
  removing  

  blank pages,   101  
  cells,   94  
  comments,   137  
  cover pages,   100  
  drop caps,   110  
  Quick Parts,   89  

  resizing,   96  
  Review tab,     135
  Reviewing Pane,   139  
  saving documents,   79  
  selecting text,   81  
  Show Markup drop-down menu,   138  
  splitting table cells,   97  
  start screen,   2-3    
  starting a blank document,   77 - 79  
  styles, applying,   87  
  tables  

  creating,   90  
  Quick Tables,   91  

  themes,   86 ,  130 - 131  
  Track Changes feature,   134  
  tracking changes with document reviewers,   

134 - 135  
  View modes,   132  
  viewing document markup,   138  
  zooming in and out of documents,   142 - 143   

   WordArt  
  formatting,   39  
  inserting,   38   

   workbooks (Excel),   144  
  creating blank,   148  
  creating from templates,   146 - 147  
  protecting with passwords,   158 - 159   

   worksheet tabs (Excel)  
  coloring,   155  
  renaming,   155   

   worksheets (Excel),   144  
  deleting,   156  
  formatting  

  adjusting column width,   168  
  adjusting row height,   169  
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  applying cell styles,   165  
  fi ltering data,   174 - 175  
  fi nding data,   170  
  freezing panes,   171  
  merging and centering text,   163  
  numbers,   164  
  sorting data,   172  
  as tables,   166 - 167  
  wrapping text,   162  

  formatting basics,   161    
  hiding,   157  
  inserting,   154  
  navigating,   149  
  tabs  

  coloring,   155  
  renaming,   155   

   wrapping text (Excel),   162   

   X-Y-Z   
   XPS documents, saving as,   22 - 23   

   zooming in and out of documents (Word),   142 - 143           
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